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1. What’s New in Version 4.3 
 

The TOXCHEM V4.3 builds on the features of TOXCHEM V4.2 which was released in 2013. 

TOXCHEM V4.3 includes a variety of new processes to model the air emissions  at the 

wastewater treatment plant, including a bar screen, V-notch weir, membrane bioreactor, water 

scrubber, closed surge tank and floating roof storage tank. In addition, the ability to model air 

emissions from a layer of oil floating on the water surface has been added to preliminary 

treatment processes, with the inclusion of four procedures for estimating the emission rates. To 

further improve the ease of use and functionalities of software, selected new features are added 

to the Graphical User Interface. A brief introduction to new features of TOXCHEM V4.3 is 

provided below.  

1.1 NEW UNIT PROCESSES 
 

Bar Screen - As wastewater passes through the bars of the bar 
screen process, resistance to the flow dissipates energy, which 
can cause turbulence and eddies, thereby resulting in air 
emissions. The bar screen emission model is developed by 
converting the head loss in the process to dissipated energy, 
which is then used to estimate the surface mass transfer 
coefficient for volatilization. 
 

 

Weir Process - The weir process is provided as a unit for 
estimating air emission losses of organic compounds as water 
drops over a V-notch (saw-tooth) weir.  The weir model is one of 
two volatilization mechanisms in primary and secondary clarifiers, 
surface volatilization being the other mass transfer mechanism. 
The volatilization models for weirs involving primary- and 
secondary-treated wastewater as proposed in Pincince (1991) are 
used.  
 

 

Closed Surge Tank - The closed surge tank is a vessel in which 
the volume of wastewater in tank changes over time. The 
emissions from this tank take place during filling. As the 
wastewater volume fills the tank during the specified time period, 
an equivalent volume of headspace air is expelled through an 
opening in the cover, such as a vent stack or open grate. The 
model for this unit process assumes that the headspace air inside 
the tank is at equilibrium with the water phase. 
 

 

Floating Roof Tank - The emission model for floating roof tank 
assumes that the main source of air emission from this tank is the 
exposed clingage of water/oil layer on the periphery of the floating 
roof tank sidewall. The exposed clingage arises when the floating 
roof move down due to withdrawal of liquid in the tank. The 
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composition of the clingage is assumed to be same as the 
average composition of the influent tank, Exposed clingage height, 
clingage thickness and exposure time are used to estimate the 
amount of emissions. 
 
Membrane Bioreactor - A new air emission model is developed 
for membrane bioreactor (MBR) considering the effect of the 
coarse bubble backwash of membranes. The process estimates 
air emissions from normal aeration and coarse bubble backwash. 
The total air emissions from the unit process is then calculated 
based on the on the frequency of the coarse bubble backwash. 
  

Water Scrubber - The new unit process is added to transfer the 
contaminant from an air stream to water stream. The emission 
model for the scrubber uses the same model as the cooling tower 
model in Toxchem, only with transfer between liquid and gas 
phases reversed.     
 

 
 

1.2 NEW EMISSION MECHANISM FROM FLOATING OIL SURFACES  
 

The issue of modeling of air emissions of organic compounds from a non-aqueous layer floating 

on a water surface is of growing concern. Originally, Toxchem software was intended to predict 

the fate of contaminants in wastewater. In certain specific industries, such as petroleum refining, 

however, it is possible that the surface of the wastewater in collection or treatment process units 

may be covered by a floating layer of oil, assumed to be of hydrocarbon origin. Users can 

specify the fraction of the water surface that is covered by the floating oil layer. In Version 4.3, 

TOXCHEM provides four procedures for estimating emissions of organic contaminants from a 

floating oil layer. The first approach (default) is based on mass transfer principles similar to 

volatilization from a water surface. The additional procedures are provided based on 1) an EPA 

approach as defined the in the document “Air Emission Models for Waste and Wastewater 

(EPA, 1994), 2) a modified EPA approach considering the mole fraction correction factor for 

dilute concentration of contaminant in oil and 3) application of direct experimental mass transfer 

coefficient  in the emission calculations. 
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1.3 NEW DATABASE PROPERTIES 
The organic contaminant database now includes the chemical formula of organic compounds.  

 

 

For user-defined organic compounds only, a temperature correction coefficient for Henry’s law 

constant can now be specified by a user in place of the default value of 1.044. Also, for user-

defined compounds, the mass transfer adjustment factor for estimation of emissions from an oil 

layer rather than from water is provided in the same tab for “Stripping” properties. 
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Lastly, the values of dissociation constants for weak acids and bases have been reviewed an 

updated as needed. 

 

1.4 INTERFACE IMPROVEMENTS 
 

Quick Adjust Panel - The new feature in the Quick Adjust Panel allows the user to include the 

physical-chemical properties of contaminants for quickly changing the values and running the 

simulations. The values of the parameters on the quick panel can also be imported from a data 

file.  

Color-coding of Stream Lines - Stream lines representing flows of water effluent, air, sludge 

and oil are now color-coded to make differentiation of the streams more discernible to users.  

Stream colors can be preferentially adjusted by a user.  

Extended Functionality of Back-Solver - The back-solving function has been extended to 

allow users to solve back from a state variable such as flow to the influent level.  Note that when 

certain state variables such as suspended solids are specified as a process data entry, setting 

the target value may result in a process mass balance failure. 
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Contaminant Substitution – In larger layouts with many influent process streams, users may 

find it advantageous to substitute one compound for another during evaluations.  For example, a 

user-defined compound may need to replace the default compound in an assessment.  Rather 

than manually deleting the existing compound and then adding the replacement compound, 

users may substitute the replacement compound easily.  

 

 



TOXCHEM  V4.3 2014 

 

10 | Hydromantis Environmental Software Solutions, Inc. 

 

Archive Layouts - This new feature will bundle any user-defined contaminants that are used in 
a layout with the layout file so that you can easily send it to a colleague and they can open the 
layout and be assured that they are using the exact same parameters.   

 

New Summary Table - With this feature, accessed through the “View Summary Results”, users 

can create and view results without the need to export the data to an Excel file. 
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2. TOXCHEM INTERFACE BASICS 

2.1 INTERFACE TERMINOLOGY 

A brief introduction of TOXCHEM V4.3 interface is presented in this section to familiarize the 

user to the organization of various features and functionality available in the simulation system. 

TOXCHEM starts with a program window as shown in Figure 2-1. The program window 

contains the areas for Menu Bar, Tool Bar, Hot Spot Bar, Process Tool Bar and Layout Drawing. 

It also contains the two quick output tables summarizing fate of contaminant in each unit 

process and the system. 

 

Figure 2-1 TOXCHEM program window 

 

2.2 INTERFACE COMMANDS/FEATURES 
Menu Bar - The Menu Bar contains menu items like File, Edit, View, Layout, Databases, Model, 

Analysis and Help. The various commands available in each menu item are as shown in Figure 

2-2. The File menu contains command for retrieving and saving the TOXCHEM files. The Edit 
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menu provides commands for manipulating the layout on the drawing area. The View Menu 

provides many different options for displaying the layout on the drawing area.  The View Menu 

also includes the command for viewing the model Preferences like the system of units, solver 

accuracy and other user preferences.  The Layout menu provides command to manage 

multiple layouts in the same file. It also includes the commands like Site Properties and 

Emission Hotspots, which are used to set layout specific properties. The Databases menu 

contains commands to access and manipulate the organic contaminant and metal properties 

database. The Model menu includes command for checking, solving and viewing results after a 

layout is completely defined. The Analysis menu provides access to Sensitivity Analysis and 

Back Solver functions of TOXCHEM. The Help menu may be used to access the User’s Guide 

and Technical Manual.  

 

Figure 2-2 Commands in different Menu items 

 

Tool Bar – The Tool Bar contains buttons for some of most often used commands in 

TOXCHEM. The menu items and corresponding commands available on the commands on tool 

bar are as shown in Figure 2-3. The Tool Bar also contains a contaminant selection drop down 

menu which can be used to select a contaminant for which hot spot display and quick outputs 

needs to be viewed. At the far right end of the Tool Bar, there is a button to access the 

Contaminant Database. 
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Figure 2-3 Commands on the tool bar and icon representation  

Hot Spot Bar – The Hot Spot Bar provides quick access to view and edit the hot spot display 

setting. It also shows the current color code used for different emission limits.  

Process Tool Bar – The Process Tool Bar provides access to all the unit processes available in 

TOXCHEM for layout building. The process units are compiled in different categories of 

Influents, Collection, Preliminary Treatment, Biological Treatment, Solid Digestion, Air 

Treatment, Dewatering, Miscellaneous and Effluents. The unit processes available in any 

category can be accessed by clicking on the category tab. 

Layout Drawing Area – The Layout Drawing Area is used for placing the process units and 

connecting them to make a process flow scheme for analysis. The layout drawing area is 

specific to the layout name which appears at the bottom-left of the drawing area. 

Unit Process Mass Balance Table – After the layout is solved, the table is used to show the 

speciation and mass balance of a selected contaminant for all the unit processes in the layout. 

System Summary Table – After the layout is solved, the table shows the overall fate of a 

selected contaminant in the system. 

Quick Adjust Panel – The quick adjust panel that can be used to place important model 

parameters which needs to be changed while conducting different simulations. The model 

parameters placed on the quick panel can also be read from an EXCEL file. 
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3. TUTORIAL  
 

3.1 INTRODUCTION 
This Tutorial describes various features of TOXCHEM and demonstrates how to conduct a 

contaminant fate modeling in TOXCHEM. After completing this chapter, user shall be able to 

understand; 

1. How to build a plant layout 

2. How to select a contaminant from the ready to use database 

3. How to set inputs for process units 

4. How to set emission hotspots 

5. How to conduct simulation 

6. How to view results 

7. How to export results 

8. How to add user defined contaminants 

9. How to conduct sensitivity analysis 

10. How to use back-solver 

 

In this tutorial, we will be working with a relatively simple treatment process configuration called 

the Tutorial Plant. The schematic form of the plant is shown in Figure 3-1.  The liquid process 

train of the Tutorial Plant consists of the following processes: 

1. Equalization basin 

2. Primary clarifier 

3. Aeration basin 

4. Secondary clarifier 

The solid process train of the plant handles the waste solids and consists of the following 

processes: 

1. Anaerobic digester 

2. Belt filter press  

In addition to the liquid and solid trains, the plant consists of an air process train which consists 

of a single unit process of digester gas cleaning process.  

The objective of this simulation study is to quantify the pollution loads of selected contaminants 

in the liquid, solid and air effluents streams from the plant. 
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Figure 3-1 Process Schematic for Tutorial Layout 

 

3.2 CREATING THE PLANT LAYOUT 
Note to Users of TOXCHEM 3 and earlier Versions: The grid designation system is no longer 

used since V4.  Also the technique for configuring the layout is no longer based on a select and 

click-in-place action, but a drag-and-drop action. 

Selecting Unit Processes To prepare the plant layout, select the unit processes from the unit 

process table available at left side of the drawing board. The unit process table consists of 

various tabs containing various unit processes. Left clicking on any tab expands the tab and 

provides the details of unit processes available in that tab. For building the Tutorial Plant layout, 

the process units listed in column 1 of Table 3-1 will be used. The Table 3-1 also provides the 

description of the category under which the process unit is found. To place the unit process on the 

drawing board, click on the tab under which the process unit is available. Left click on the process 

unit and drag to the drawing board while keeping the mouse button pressed. Release the mouse 

button to drop the unit process at the desired location on the drawing board. To remove a unit 

process from the drawing board, right click the mouse button on the process and click delete from 

the pop-up window.  Another way to delete the unit process is by left clicking on the unit process 

[a red border around the object appears] and then accessing the delete command inside edit 

menu or on Tool Bar. The delete key on the keyboard can also be used for deleting the unit 

process [Note: At present TOXCHEM does not support a “Undo” button]. To move a process unit 

from one cell to other, left click on the process unit and move the cursor to the new location with 

the mouse button pressed. Release the mouse button to select the new location. The move 

operation can be performed for a group of selected process units. When all the process units have 
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been added to the drawing area, optimize the screen view by clicking on <View/Zoom> and 

selecting “to Entire Plant” [Zoom to Entire Plant command is also available on Tool Bar for quick 

access]. The drawing board after the unit process placement shall appear as shown in Figure 

3-2 .  

Table 3-1 Process Units Required in Tutorial Layout  

Unit Process Category Comment 

Wastewater Influent Influents The influent object are used to specify the 
wastewater flow rate, contaminants 
concentration etc. 

Equalization Preliminary Treatment In this exercise the hydraulic mixed tank is 
used. 

Primary Clarifier Preliminary Treatment - 

Activated Sludge – 
Diffused Aeration 

Biological Treatment The diffused aeration unit is selected in this 
exercise. 

Secondary Clarifier Biological Treatment - 

Pass Through Miscellaneous The Pass Through object allows to visualize 
the properties of the incoming stream 

Anaerobic Digester Solids Digestion - 

Belt Filter Press Dewatering Belt filter press process unit is used in this 
exercise. 

Air Treatment Air Treatment - 

Wastewater Effluent Effluent - 

Air Effluent Effluent Used to collect air from all the unit 
processes except anaerobic digestion 

Air Effluent Effluent Used to collect air from the anaerobic 
digestion object 

Sludge Effluent Effluent - 
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Figure 3-2 Drawing Board after Placing the Process Units 

  

Making Flow Connections After all the required process units are placed on the drawing 

board, the flow connections between the unit processes are defined. The process connections 

required to make the layout are shown in Table 3-2 which also lists the connection types 

between the process units.  

Note: In TOXCHEM, there are four types of connections e.g. wastewater connection, sludge 

connection, air connection and oil connection available to the user. The nature of the connection 

points can be checked by right clicking on process unit and then selecting the “Edit Labels” in 

the popup window. The “Edit Label” window as shown in Figure 3-3 indicates the nature of the 

connection. The connection points can also be identified by the fill- colour of arrow which 

appears when the cursor is placed over the connection point.  The wastewater, sludge, air and 

oil connection points bring up arrow filled with grey, brown, blue and black colour respectively. 

In TOXCHEM, it is permitted to make a connection between wastewater and sludge lines. 

However air and oil streams can only be joined to respective colour streams. This means that 

while the wastewater and sludge connection lines can be interconnected without discretion, the 

air and oil streams can only be joined to respective connection type. 
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Table 3-2 Process Connections for Tutorial Layout 

From  Process Connection Type To Process 

Influent Wastewater Equalization 

Equalization Wastewater Primary Clarifier 

Equalization Air Air Effluent 

Primary Clarifier Wastewater Diffused Air Activated Sludge 

Primary Clarifier Air Air Effluent 

Primary Clarifier Sludge Anaerobic Digester 

Diffused Air Activated Sludge Wastewater Secondary Clarifier 

Diffused Air Activated Sludge Air Air Effluent 

Secondary Clarifier Wastewater Effluent Discharge 

Secondary Clarifier Air Air Effluent 

Secondary Clarifier Sludge Diffused Air Activated Sludge 

Secondary Clarifier Sludge Flow Through 

Flow Through Wastewater Anaerobic Digester 

Anaerobic Digester Wastewater Equalization 

Anaerobic Digester Air Air Treatment 

Anaerobic Digester Sludge Belt Filter Press 

Belt Filter Press Wastewater Equalization 

Belt Filter Press Air Air Effluent 

Belt Filter Press Sludge Sludge Discharge 

Air Treatment Air Air Effluent 2 

Wastewater Effluent   

Air Effluents   

Air Effluents 2   

Sludge Discharge   
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Figure 3-3 Verification of connection types for primary clarifier 

To collapse the quick adjust panel, click on the right facing triangle available on the divider 

between the drawing board and the quick adjust panel. The quick adjust panel can be displayed 

when necessary by clicking on the left pointing triangle. The process tool bar on the left side can 

also be collapsed/displayed by using the left and right pointing triangles available on the divider 

between the process tool bar and the drawing board. For this exercise, collapse the quick adjust 

panel by clicking on the right pointing triangle. 

To make a connection between two process units, place the mouse on the outlet arrow 

connection of the unit process from where the connection starts. Once the cursor is at the right 

position, a larger right facing arrow will appears. Press the left mouse button to connect to the 

outlet and drag the mouse cursor to the inlet connection of the unit while keeping the mouse 

button pressed. When the cursor is at the proper position on the inlet arrow connection, a larger 

right facing green colour arrow will appear. Release the mouse button to accept the connection. 

A connection line between the units should appear after the operation. For deleting a 

connection, right click on the process unit from where the connection to be deleted originates. In 

the pop-up window, point the cursor on Delete Connection and select the connection to be 

deleted. Another quick way to delete the connection line is to right click on the line and left click 

on Delete Connection in the pop-up window. 
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Follow the connection list in Table 3-2 and repeat the operation to connect all the unit 

processes. Both inlet and outlets connection points of process units allows multiple connections 

as long as they are of same type.  

Note: TOXCHEM requires that all the outlet connections on all the unit processes are connected 

to a downstream process unit. Therefore, in a TOXCHEM layout, the wastewater line, sludge  

line, air line and oil line always terminate at a wastewater effluent, sludge effluent, air effluent 

and oil effluent process objects [only objects without an output connection] respectively.  

When all the connections are complete, verify that all the process connections are valid by left 

clicking on the green check-mark and arrow button available on the tool bar. Alternatively select 

the Check Connection from the Model menu. The missing connections in the layout will be 

displayed in a pop-up information window. Define the missing connections to complete the 

layout.  You can also rearrange the connection lines by dragging then horizontally or vertically. 

The completed layout will now appear as in Figure 3-4. 

Note: the Check Connection feature only identifies the missing connections, it cannot 

determine if the connections are correct. 

 

Figure 3-4 Example Layout with Process Connections 

There are several display options in TOXCHEM which are accessible from the View menu. To 

display/hide the process labels select/unselect the Display Process Labels in View menu. 

Similarly, to display/hide the stream labels, select/unselect the Display Stream Labels in View 
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menu. The layout with both the process and stream labels selected is shown in Figure 3-5. 

The display of process and stream labels can also be turned On/Off by right clicking in an empty 

cell on the drawing board and (un)selecting Display Process Labels or/and Display Stream 

Labels. 

 

Figure 3-5 Example Layout with Process and Stream Labels Activated 

TOXCHEM automatically decides the path of the connection lines between two unit processes. 

At times, the paths of the connection lines may almost appear to overlap, and so are not 

optimally placed. In such situation, the automatically drawn path of the connection lines can be 

rearranged by the user. The lines can be moved by left clicking on the line and dragging it in the 

indicated (horizontal or vertical) direction. It shall be noted that only one segment of the line 

between two break-points (In automatically drawn lines, the break-points exist at each 

connection point and at the point of change in direction) can be moved at a time. Additional 

break-points can be created on a line by left clicking on the line where a break-point is 

necessary and left clicking on Create Break Point. The example layout with the connection 

lines redrawn is as shown in Figure 3-6. 

[Note: if the unit process is moved, all the connection lines originating from the unit processes 

will be redrawn by TOXCHEM] 
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Figure 3-6 Example Layout with connection lines reorganized 

Note: TOXCHEM automatically assigns both the process and stream labels. The process label 

is assigned when the process object is placed from the process table to the drawing board. A 

stream label is assigned when the connection point is connected to a downstream object. To 

change the automatically assigned labels to more user meaningful labels, right click on the 

process object and select Edit Labels in the pop-up window. Enter the new process/stream 

labels in the process/stream label field of the edit label window. Press Accept to confirm the 

changes.   

In this layout, we will change the labels for the secondary clarifier. Right click on the secondary 

clarifier and select Edit Labels. In the Edit Labels window, change the labels as shown in the 

Table 3-3. 

To access the second sludge stream of the secondary clarifier, click on the selection box next to 

the sludge stream and select To-Point and then change the connection label. The Edit Label 

window after the changes shall be as in Figure 3-7. 
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Table 3-3 New Stream Labels 

Stream New Label 

From - AS diffused AS_eff 

To - Air effluent Cl_air 

To - Wastewater effluent Cl_eff 

To-AS diffused RAS 

To-Point WAS 

 

 

Figure 3-7 Edit Label Window with New Stream Labels 

 

3.3 DATA ENTRY 
Note: TOXCHEM organizes data inputs into three categories - Global Data, Layout Specific 

Data and Unit Process Specific Data. The Global Data form can be accessed by going to View 

Menu and clicking on Preferences command. The Global Data controls the display and model 

settings for all the layouts in the project file. In the Display Settings tab, settings like significant 

digits in output numbers and Default Unit System (metric, US) are accessible to user. In the 

Model Settings tab user can set the accuracy of the steady state solver and can choose the 

biological model for suspended growth processes. The layout specific data is applicable to the 

layout and can be set for each layout differently. The unit process data is specific for the specific 

unit process for which the data is provided. In this exercise we will only change the Layout 

Specific Data and Unit Process Specific Data. 
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LAYOUT SPECIFIC DATA 

To input the layout specific information, access Site Properties in the Layout menu. The Site 

Properties window is as shown in Figure 3-8. In this exercise, we will leave all the parameters 

to their default value. Note that the wind speed, which affects surface volatilization is 10 km/h 

(6.2 mph) and the site elevation and site wide pH value are 100 m (328 ft) and 7.0 respectively.  

Note: To enter the data in units other than default units, click on the inverted triangle next to the 

data entry field. Select the required unit in the popup window. TOXCHEM provides a choice to 

apply SRT based active biomass correction in the biodegradation rate. By default, the correction 

factor is not applied. 

 

Figure 3-8 Site Properties input window 

 

UNIT PROCESS SPECIFIC DATA 

Note: Unit process data Entry is now accomplished by right-clicking on the process unit and 

then clicking on Edit Parameters in pop-up window 

Influent - On the Data Entry tab of the Influent data input window, set the wastewater flow to 

30,000m3/d (7.925 MGD). The temperature and suspended solids concentration of the influent 

are set to 40oC (104oF) and 250 mg/L respectively.   All the other input parameters are left with 

their default values.  It should be noted that as soon as the default values are changed the 

display color changes to blue. This change in color helps user keep track of values which are 

changed in the model. After the changes have been made, the user can view the original default 

values by pointing the cursor over the field. A tool tip will display the default value. A help button 

is available at the bottom left of the form to access brief description of the input parameters. The 

Data Entry form after entering the influent data is shown in Figure 3-9. 

 



TOXCHEM  V4.3 2014 

 

25 | Hydromantis Environmental Software Solutions, Inc. 

 

 

Figure 3-9 Data Entry tab for the Wastewater Influent 

To select and enter the concentration of contaminants, click on the Contaminants tab. The 

Table 3-4 shows the contaminants and their concentration which will be included in the fate 

modeling.  

Table 3-4 Contaminants and Influent Concentrations for Tutorial Layout 

Compound Influent Concentration (ug/L) 

Acetone 1,000 

Benzene 100 

Chloroform (Trichloromethane) 10,000 

Methanol 50,000 

 

Click on the Add/Remove button to begin selection of contaminants from the TOXCHEM 

database. Scroll through the list of contaminants to find the contaminant of interest. To quickly 

find the contaminant in the list, enter the first letter of the contaminant (or a few letters quickly). 

Select the contaminant of interest by clicking on it. After selecting the contaminant, click the 

right-facing arrow button in the center of the window to include the contaminant in the 

wastewater. The name of the contaminant will appear in the window on the right side of the 

selection panel. Once all the contaminants have been selected, click on the Accept button. 

Clicking the Accept button closes the contaminant selection window and shows data entry 

window to input the concentration of each selected contaminants.  On this screen change the 

concentrations of the contaminants as shown in Table 3-4. The Contaminants tab after 

selecting and entering the contaminant concentration is as shown in Figure 3-10.  After 

changing the concentration click the Accept button on the window to close the data entry 

window.  
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Figure 3-10 Contaminant tab showing the selected contaminants 

Alternatively, the contaminants and their concentrations can be imported from an EXCEL file by 

using Import button on the window. The procedure to import data from an EXCEL file is 

described later in Chapter 4- Additional Topics. 

Equalization Basin-Change the equalization basin depth to 3.5 m and area to 40,000 m2 Use 

the inverted triangle next to the data entry field to select the correct units (Figure 3-11). 

 

 

Figure 3-11 Data Input for equalization basin 
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Secondary Clarifier - In the secondary clarifier process, open the data entry form by right 

clicking on the object and selecting Edit Parameters.  Once in the data entry window, click on 

the flow split tab to set the flow split fractions of the sludge stream. Depending on in what 

sequence the stream connections were made, either RAS or WAS stream fraction may appear 

with an editable field.  In this example, the RAS flow split field is editable. Set a flow fraction of 

0.98 and enter to see the recalculated WAS split fraction. Alternatively, if the Waste Activated 

Sludge (WAS) stream shows up with an editable fraction then set the sludge flow split fraction to 

0.02. The Flow Split set up screen for the Secondary Clarifier is shown in Figure 3-12. Press 

enter after typing in the split fraction and make sure that the split fraction of other stream is 

correctly calculated. 

 

Figure 3-12 Specifying split fraction of the underflow stream 

Note: The split fractions are specified for all but one stream. The split fraction for the 

unspecified stream is calculated as the difference of one minus the sum of the split fractions of 

other streams. 

For all the other process units, use the default values. 

3.4 SET EMISSION HOTSPOTS 
In TOXCHEM by using the “hotspots” feature, it is possible to visually differentiate the process 

units which are minor/major source of air emissions in a wastewater treatment facility.  When 

the hotspot feature is activated, the unit processes appear surrounded by different colors, 

depending on their emission rates.  Up to 4 different colors can be used.  The classification 



TOXCHEM  V4.3 2014 

 

28 | Hydromantis Environmental Software Solutions, Inc. 

 

ranges can be based on either estimated emission rates (g/d or lb/d), or as a percent of the total 

input mass. 

To set the emission limits for the hotspot, access the Emission Hotspots from the Layout 

menu item.   For this exercise, the ranges designated will be based on % emission rates.  The 

settings are as shown in Figure 3-13. After inputting the values, click the Accept button to 

confirm the settings.  The hot spots will be only visible if the hot spot tool bar is activated from 

View – Toolbars Menu. It shall be noted that Emission Hotspots setting is not applicable to 

metal, which do not contribute to air emission. 

 

Figure 3-13 Definition of Hot Spot Emission Categories 

3.5 RENAME THE LAYOUT 
The name of layout appears at the bottom-left of the drawing area. Right-click on the Layout1 

and select Rename from the drop down menu. Enter PlantABC in the layout rename window. 

Press OK to accept the change.  

3.6 SAVE THIS PLANT LAYOUT 
Save the file as tutorial.tox by selecting Save from the File menu in appropriate directory. 

Note: Layout files since Version 4 are designated by the file extension <*.tox>. The file name 

can be different than the name of the layout given in above section. 

3.7 RUNNING THE SIMULATION 
Now that the plant schematic has been prepared and necessary data have been entered, it is 

time to perform simulation. Click on the Calculate button on the toolbar to start the calculation. 

The solver starts the calculation and solves the model. If no errors are encountered, a pop-up 

window will appear with the message “Layout successfully solved”. Click the OK button to close 

the popup window. In Version 4.3, a summary of total air emissions of all compounds is 

displayed in the upper right corner of the layout. After the layout is solved, the unit processes 
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are presented with different colors around them. If the different colors do not appear, then 

activate the hotspot display by selecting Hotspot toolbar from the View – Toolbars menu. The 

hot spot feature provides a quick way to identify the major source of air-emission for a selected 

compound. To check the emission hot spots for other compounds, select the contaminant from 

the drop-down box provided in the tool bar for hot spots. The Figure 3-14 shows the hot-spot 

coloring for the Chloroform. 

 

 

Figure 3-14 Model Interface with Emission Hotspots Activated 

3.8 VIEW AND EXPORT RESULTS 
Note: TOXCHEM provides many different ways of viewing simulation outputs. In addition, the 

fate summary table and overall system mass balance tables are displayed on-screen for quick 

review.  

After the layout is successfully solved, the simulation results can be viewed. Right click on the 

object and select View Results to view the outputs for an individual object. To view a detailed 

summary of the simulation results for complete layout, it is better to use the View Results 

button available on the tool bar. 

VIEW RESULTS FOR UNIT PROCESS 

Right click on the activated sludge tank and select View Results. In the output window of the 

process unit (Figure 3-15), click on the various tabs for viewing the values of different 

parameters. The values for different contaminants can be displayed by selecting the chemical 

from the drop down menu available at the top left corner of output window. The results for every 

process unit can be viewed similarly. 
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Figure 3-15 Output window for Activated Sludge-Diffused Air  

Fate summary tab provide the process and overall process emission summary. Open the fate 

summary tab (Figure 3-16) and click on the graph icon at the bottom left of the window for 

graphical view of the fate summary chart or emission chart.  
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Figure 3-16 Fate summary tab for Activated Sludge-Diffused Air 

Note: depending on the process unit, the output window may consist of different tabs. The 

parameters on the influent tabs are the values for the combined wastewater and sludge influent 

lines.  For the Effluent-Air stream, all emissions from open tanks are provided as a mass rate 

only; emissions from covered tanks are provided both as concentration and mass rate. 
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CONTAMINANT FATE TABLE 

A contaminant fate table is generated as soon as the layout is solved. The contaminant fate 

table is available for view at the bottom right of the screen (Figure 3-17). The table lists all the 

unit processes in the layout and provides information regarding the total load of incoming 

contaminant and its fate in the unit process. Left clicking on a unit process in the layout, 

highlights the corresponding mass balance row in the table and vice-versa. An additional button 

for viewing results is also provided besides the unit process ID. Clicking on the button, shows 

the same screen as available from the View Results command associated with each unit 

process. 

 

 

Figure 3-17 Contaminant fate table 

 

OVERALL MASS BALANCE TABLE 

On the left side of unit process contaminant fate table, an overall mass balance table is 

provided. The table shows the total incoming contaminant load and its fate in the system. The 

mass balance table for chloroform is as shown in Figure 3-18. It can be seen that, 47.3% of 

the incoming Chloroform is expected to go in the air stream, while 47.4% is expected to 

biodegrade.  

 

 Figure 3-18 Overall mass balance table for Chloroform 

Just above the overall mass balance table, three command buttons are provided for visualizing 

the outputs in the graphical format, exporting the data to EXCEL and copying the Tables to 
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clipboard. Click on the Show Graph button to visualize the fate summary data in a graphical 

format. The Fate Summary tab contains a chart (Figure 3-19) providing a visual depiction of 

the various fate mechanisms of the contaminant for the whole layout.  On the other hand the 

Emissions Summary tab contains a chart shows the mass emission rate from each process unit 

in the facility. 

 

Figure 3-19 Emission Summary chart 

VIEW RESULTS FOR COMPLETE LAYOUT 

To view the results for the layout in other formats, select the View Results in the Model menu. 

Alternatively, click on the View Results button available on tool bar. Activation of View Results 

opens a Results window with 4 output options. The output from each option is described below. 

1. Air Emissions – Air emissions are tabulated for each contaminant from each process or 

vice versa. 

2. Contaminant Fate – Group by contaminant – The fate of selected contaminant for all unit 

processes in the layout is summarized. 

3. Contaminant Fate – Group by unit process – The fate of all contaminant at a selected 

unit process is summarized. 

4. System States – Group by contaminant – For a given contaminant, the states are 

tabulated for each stream in the layout. 

The first option of Air Emissions provides the summery of air emissions that can be used for 

preparing emission reports (Figure 3-20). The column and rows in the air emission table 

can be switched by using the row –column invert button provided on the top right of the 

table. 
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Figure 3-20 Output Options Window for different Table Types 

Custom reports can be generated by using the Stream States – group by contaminant option. 

The user can click the Edit Properties button on the top right side of the table to select the 

Process Streams (effluent, sludge, air) and the state variables of interest associated with the 

process streams.  In the stream and state selection window, all the streams and state variables 

are selected by default. Click on the None button for both the Process Stream choices and 

State Variable choices. Now, under the Process Stream choices, click to select the following: 

Wastewater Influent 
Air Effluent 
Secondary Clarifier 
Air Effluent (2) 
Sludge Effluent 
 

The individual influent and effluent streams for any unit process can be accessed by clicking on 

the + mark on the left of the process unit. Click on the + sign next to the Secondary Clarifier 

process to see all the influent and effluent streams. Depending on the requirement, the stream 

outputs can be included or excluded by selecting/deselecting the stream. For the Secondary 

Clarifier, de-select the stream with labels AS_eff, RAS (return activated sludge), Cl_air (air 

emission from clarifier) and WAS (waste activated sludge).  Only Cl_eff remains selected, which 

is the treatment plant effluent. 
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Now expand Air Effluent process to see all the incoming streams. As all of the incoming air 

streams contribute to the total plant air emissions, let all the streams be selected.  Note that 

Cl_air is the secondary clarifier air emission, which was de-selected in the clarifier unit process. 

Now the state variables to be included in the report need to be selected. From the checklist, 

select Flow Rate, Total Suspended Solids, Organic Chemical Mass, Organic Chemical Cl, 

Organic Chemical Ct and Temperature. The Cl and Ct represent the liquid phase and total (liquid 

and solid phase) concentrations of the organic chemical. The selections for the streams and 

states are shown in Figure 3-21. Click on the Accept button to see the output screen as 

shown in Figure 3-22.  

The data shown in the screen is for Chloroform. To view the data for other compounds, simply 

click on the contaminant dropdown list above the table and select the compound of interest for 

the fate summary.   

The tabulated data can be exported to EXCEL or clipboard by using the Export Data and Copy 

Table to Clip Board button provided at the top left side of the table. 

 

Figure 3-21 Selection of Process Streams and State Variables for Report 
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Figure 3-22 Output Report for the Selected Streams and State Variables 

3.9 GENERATE REPORT 
In addition to the above features for viewing and exporting data, TOXCHEM allows user to 

generate an elaborate report containing information for all the process units and flow streams. 

To generate a report, select Generate Report from the Model menu.  In the Report Setup 

window (Figure 3-23), keep the default settings in the Options and File Format items. Press 

Accept to start the process of report generation. If required, change the name of the file and/or 

directory where the file should be saved. If view report on completion selection box was 

checked in the Report Setup window then the report will be displayed in the Excel file format 

which was selected on the Report Setup window. 
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Figure 3-23  Report Setup Window 

 

3.10 ADDING PARAMETERS ON THE QUICK ADJUST TOOLBAR 
Display the quick adjust panel by clicking on the left pointed arrow on the divider between the 

drawing board and the quick adjust toolbar. In this exercise we will place the following 

parameters (Table 3-5) for different unit processes on the quick adjust panel. 
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Table 3-5 Parameters to be Placed on Quick Adjust Toolbar 

Object Parameter 

Influent Flow Rate 

Influent Suspended Solids concentration 

AS- Diffused Air  Air Flow Rate 

AS- Diffused Air MLSS concentration 

Secondary Clarifier Sludge SS concentration 

  

To place a parameter on the quick adjust toolbar, open the Data Entry form by right clicking on 
the object and selecting Edit Parameters. Right click on the parameter that needs to be placed 

on the quick adjust toolbar and click on the “Pin to Quick Adjust Toolbar” (Figure 3-24). Repeat 

the steps for each parameter to be placed on the quick adjust toolbar. 

 

 

Figure 3-24 Data Entry Form for Selecting Parameters for Quick Adjust 

 

After completion of the above procedure the Quick Adjust Toolbar on the right hand side look 

like  Figure 3-25.  
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Figure 3-25 Quick Adjust Panel with Selected Parameters 

 

To differentiate between various parameters, it is a good idea to label these using the “Add a 

Label” command from the Options button available at the top –right of the quick adjust panel. 

Select the parameter above which a label needs to be placed e.g. Flow Rate and click on the 

Options button and Select “Add a Label”. In the New Label, add Influent ABC and press OK. 

The label Influent ABC will appear above the Flow Rate Parameter. Similarly add AS-Diffused 

and Secondary Clarifier Labels to distinguish the parameters belonging to different unit 

processes. After adding the labels, the completed model shall appear as shown in Figure 3-26. 

If while adding the label, the label appears at wrong place, it is possible to click and move it 

around. To remove a label, right click on the label and select Remove Label.  
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Figure 3-26 Quick Adjust Toolbar with Labels 

 

New in V4.3 is the ability to vary the values of compound physical and chemical properties of 

user-defined chemicals. For example, the impact of varying a first order biodegradation rate 

coefficient can be tested by pinning the parameter to the toolbar.  First create a user-defined 

compound representing triclosan, an anti-bacterial agent. Find and select the user-defined 

compound in the database. Click on the “biodegradation” tab, then right click on the aerobic 

biodegradation rate (Kb) at 20 oC for liquid processes. Click on the “Pin to Quick Adjust Toolbar” 

box to send the rate coefficient to the toolbar.  Once it appears on the Quick Adjust toolbar, 

create a label for the property indicating it is the biodegradation rate coefficient for the user-

defined compound triclosan.  The Quick Adjust toolbar now looks like the figure below. 

.  
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Figure 3-27 Quick Adjust Panel with Selected Parameters 

 

Once the important parameters are placed on the Quick Adjust Toolbar, it is possible to easily 

change the parameters values for different simulations. In this exercise change, the Influent flow 

rate from 30,000 m3/d to 50,000 m3/d and run the model to see the changes in the air emission. 

Change the value back to 30,000 m3/d before continuing with the following exercise.   

3.11 ADDING USER-DEFINED COMPOUNDS 
Although the compound database in TOXCHEM is extensive (~800), the compound of user 

interest may not be available in the database.  Compounds can be added to the TOXCHEM 

database and used in modeling. Adding new compound is often useful if user wants to compare 

the fate of compound with different values of a chemical property (or more than one property).  

Compounds with user defined properties can be saved as compoundname-1, compoundname-

2, and so on, in the database.  The user defined compounds then can be included in the influent 

wastewater as compounds for evaluation.  Afterwards, any compound which is no longer of 

interest can be deleted from the database. 

 ADDING A NEW COMPOUND 

Note: The chemical property set associated with each organic compound has an updated look 

since V4. A set of tabs are used to group similar properties. A few additional properties such as 

weak acid/base dissociation coefficients are added in the database. 

In the present example, we are going to add a new compound called "test1" in the organic 
chemical database.  From the tutorial plant configuration established above select the Organic 
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Chemicals Database from the Database menu. The first compound in the Organic Chemical 

Database list is 1-2 Dimethylnapthalene, as shown in Figure 3-28. 

 

Figure 3-28 Organic Chemicals Property Set 

To add a new contaminant in the list, click on the Create New Contaminant (+ sign) button 

available at the bottom right of the contaminant list window. Clicking on the + button create a 

copy of the compound which was selected initially. As soon as new compound is created, all the 

property fields become editable. To change the name of the compound click on the Name field 

and change the name to test1. This will change the name of the compound and shift its location 

in the list according to the alphabetical order. Change the properties of the test1 according to 

the values provided in Table 3-6.  After entering all the information, set the contaminant Filter 

to User-Defined to see the test1 in the contaminant list (Figure 3-29). Once the user compound 

is added, press enter to close the window. Do not forget to press Accept to save the compound 

in the database. It is better to create a copy of the contaminant which has similar property to the 

new compound. To search a compound of interest, use the Search by Name or Search by 

CAS# search options. 
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Table 3-6 Property values for input to User Compound “Test1” 

Parameter Value Tab 

CAS No. 108-21-4 Properties 

Molecular Weight 102.13 Properties 

Density 0.87 Properties 

Vapor Pressure Unchecked Properties 

Boiling Point Unchecked Properties 

Henry's Law Coefficient at 25oC 0.01517 Stripping 

Van’t Hoff A for estimating H Unchecked Stripping 

Van’t Hoff B for estimating H Unchecked Stripping 

Log Octanol/Water Partition (Kow) 1.36 Sorption 

Sorption Suspended Growth, Kp 0.085 Sorption 

Sorption Fixed Growth, Kp Unchecked Sorption 

Sorption- Wastewater DOC (Kdoc) Unchecked Sorption 

Isotherm for Carbon (Kc) Unchecked Sorption 

Isotherm for Carbon (1/n) Unchecked Sorption 

Sludge Process - Anaerobic Biodegradation Rate Unchecked Biodegradation 

Sludge Process – Aerobic Biodegradation Rate 0.0037 Biodegradation 

Liquid Process - Aerobic Biodegradation Rate Kb  0.0037 Biodegradation 

Liquid Process - Aerobic Ks Unchecked Biodegradation 

Liquid Process – Anoxic Reduction Factor 0.8 Biodegradation 

Liquid Process – Anaerobic Reduction Factor 0.1 Biodegradation 

Classification Acid Dissociation 

First Acid Dissociation Coefficient 6.8 Dissociation 

Second Acid Dissociation Coefficient Unchecked Dissociation 

 

Note: To add multiple compounds, press + after one compound is entered and repeat the steps 

described above. There is no need to press Accept after entering each compound. However, 

once all the compounds are entered, it is necessary to press Accept to confirm the changes.  A 

user defined contaminant can be deleted by selecting the compound from the contaminant list 

and pressing Delete Contaminant (- sign) button next to Create New Contaminant (+ sign) 

button. To incorporate the new contaminant in the layout calculation, follow the same procedure 

as described in data entry for influent object. 

Any user-defined compound will be added alphabetically to the database list and its name 

appears in blue color.  Compounds with numbers (e.g. 1,4 dichlorobenzene) appear before 

alphabetical characters that start compounds.  A user-defined compound is identified by a blue 

font compared to the black font of the pre-defined compounds.  To quickly view the list of user-

defined compounds, use the “Filter” dropdown selection and click on User-defined. It may be a 

good idea to create new contaminants with a specific prefix (e.g. User_ etc.) for easy 

identification. 
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Figure 3-29 User Defined Contaminant 

3.12 SENSITIVITY ANALYSIS 
The sensitivity analysis feature is a useful tool in TOXCHEM.  It allows the user to see the effect 

of various design and operating conditions on the fate of the contaminants in the wastewater 

treatment plant.  In essence, the sensitivity analysis adjusts the magnitude of the parameter of 

interest while holding all other test conditions constant.  This enables the user to assess which 

factors are the most important in governing air emission rates or effluent concentrations. 

To illustrate the use of the sensitivity analysis, the effect of a change in the aeration rate in the 

diffused activated sludge process on the fate of chloroform will be evaluated. 

SETTING THE SENSITIVITY ANALYSIS 

Once a treatment plant layout is properly configured, it is possible to run the sensitivity analysis.  

To setup a sensitivity analysis, select Sensitivity Analysis from the Analysis menu. On the 

Sensitivity Setup window (Figure 3-30) set the Chloroform, AS-diffused and Air flow rate in the 

Contaminant, Process and Parameter selection fields respectively. Leave the View effect field at 

its default value. 
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Figure 3-30 Sensitivity Analysis window 

 

SETTING THE SENSITIVITY RANGE 

The range over which the sensitivity analysis is to be assessed must be specified.  To do this, 

first note the current value specified in the process unit is10,000 m3/h.  Suppose that the 

analysis is to examine the effect on chloroform fate over a range of 5,000 to 50,000 m3/h of air 

flow rate. Set the low value for the range at 5000 m3/h and the high value for the range at 

50,000m3/h. Set the number of steps at 10 to obtain a sufficient number of points for 

assessment. 

RUNNING THE SENSITIVITY ANALYSIS 

Click the Run Analysis button to initiate the sensitivity analysis. When it is finished, the results 

of the analysis are reported under different tabs of Percentage-graph, Mass Loading-graph, 

Percentage - table and Mass Loading- table. By default, the sensitivity analysis results are 

shown on the Percentage-graph tab (Figure 3-31). The graph on Percentage-graph tab 

indicates that the increase in aeration rate increases the fraction of chloroform that is 

stripped/volatilized, while decreasing the fraction biodegraded. On the left side of the graph, the 
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yellow color Up and Down arrows may be used to change the scale of the graph. Use the yellow 

color rectangle to reset the scale. The graph legend may be turned On/Off by using the Graph 

Legend button below the yellow arrow pointing down.  To copy the graph to the clip board, use 

the Copy Image to Clipboard button available below the Graph Legend button. Try clicking on 

other tabs of Mass Loading-graph, Percentage-table and Mass Loading- table to familiarize with 

the sensitivity analysis outputs. 

In some cases, the range of the sensitivity analysis variable may span over several orders of 

magnitude. In such situation, it may be better to plot the data on a logarithmic scale rather than 

on a linear scale. In the Range Settings header box, user can easily switch between the options 

of Linear Distribution/Logarithmic Distribution. Note that the data curves in the charts remain 

essentially unchanged after the selection is changed from Logarithmic to Linear Distribution, 

however, on the X-axis there are more data points at lower air flow rates than that in the linear 

distribution.  

 

Figure 3-31 Sensitivity Analysis Output Chart 



TOXCHEM  V4.3 2014 

 

47 | Hydromantis Environmental Software Solutions, Inc. 

 

3.13 USE OF BACK-SOLVER FEATURE 
The back-solver feature of TOXCHEM enables user to determine, for example, the required 

concentration of a contaminant in influent to meet certain specified emission criteria in a 

downstream process unit for a selected contaminant. There are a number of possible ways that 

back-solving may be applied.  For example, to stay within total emission limits, the air loading 

from an activated sludge tank is not to exceed a certain mass rate. The back-solver can work 

from the specified maximum air loading of the contaminant to arrive at the maximum 

concentration arriving at the treatment plant.  As another example, one may wish to check the 

concentration in an air stream to ensure that the compound does not exceed the lower 

explosive limit (LEL). By back-solving from the gas concentration in an enclosed headspace to 

the influent concentration, it is possible to determine the maximum allowable concentration 

arriving at the plant to avoid exceeding the LEL in the headspace location.  Another application 

may relate to the quality of residual solids disposed of off-site.  Suppose the concentration of a 

contaminant is not to exceed a certain value in the residual sludge disposed of off-site.  We can 

determine what the maximum concentration in the influent will be to avoid reaching the ceiling 

value. 

The TOXCHEM back-solver can be setup with respect to following output variables: 

Soluble aqueous concentration 

Total aqueous concentration 

Gas concentration 

Mass air emission rate 

Solid sludge concentration 

Total sludge concentration 

Total sludge dry weight. 

Configuring the Back-Solver Window 

Note: The layout of the back-solver window has been substantially altered from previous 

versions to provide a simpler interface for set-up. 

The back-solver set up window can be accessed by selecting Back-Solver from the Analysis 

menu. In the back-solver setup window, the setup options are organized under two tabs i.e. 

“Target Solution” and “Influent Manipulation”.  For this example, three scenarios as listed in 

Table 3-7 will be tested. On the Target Solution tab, enter the values from Table 3-7.  Move 

through the Table one contaminant at a time.  Click on the “+” button to add the next scenario 

after all the inputs for the first contaminant are complete. Repeat the process for the third 

contaminant.   When the three scenarios have been entered, the dialog box should appear as in 

Figure 3-32. 
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Table 3-7 Inputs for Tutorial Back-Solver Scenarios  

Scenario Name Contaminant Solution Type Process Location Solve to Value 

Methanol Ct SC Methanol Total aqueous 
concentration 

Secondary 
Clarifier 

0.02 mg/L 

Benzene MAER AS Benzene Mass Air 
Emission Rate 

AS-diffused 1.0 g/d 

Chloroform TSDW BF Chloroform Total Sludge 
Dry Wt. 

Belt Filter Press 0.5 mg/kg TS 

Notes: leave the solution accuracy at 0.01%.  

On the Influent Manipulation tab, leave the influent maximum concentration and influent 

manipulation to its default value for all the scenarios. 

 

Figure 3-32 Completed Back-Solver Scenarios 
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RUNNING SCENARIOS 

The configured scenarios can be solved by pressing Run All Scenario button or Run Selected 

Scenario button. For example, click on the chloroform scenario and then click on the Run 

Selected Scenario button. The back-solver iterates to the solution and outputs the results of 

simulation in the Results tab. In this exercise, press the Run All Scenario button to run all the 

scenario one after other. The Back-Solver results are presented in individual scenario named 

tabs. The typical output from back-solver scenario analysis is as shown in Figure 3-33. 

  

Figure 3-33 Results for Back-Solving of Chloroform Scenario 

 

The back solver estimated influent concentration can be directly transferred to the influent 

wastewater data input by clicking on the button to the right of the solution (a right-pointing arrow 

and # sign). A pop up confirmation message appear. Click on the transfer button to transfer the 

estimated value for all the three contaminants from respective tab. Close the Back Solver 
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window and go to influent unit process and check that the estimated concentration values are 

correctly updated. Run the simulation again with the new values and verify that the outputs at 

the respective unit process are as expected with the new influent concentrations. 

The options button at the bottom left of the window presents other options of exporting/ 

importing back solver scenario settings to/from EXCEL file. Also the option of transferring back 

solver estimated values for different scenarios to the influent object is available for easy transfer 

of estimated values.  

Consider now the ability added in V4.3 to solve for the required influent flow rate that would 

result In a sludge flow rate of 480 m3/d from the primary clarifier. After accessing the back-

solver, for the Target Solution, click on the Stream State button, and select “Flow Rate” from the 

list of state variables, Primary Clarifier as the Process and Effluent-Sludge as the stream type.  

Setr the target flow of primary sludge to 480 m3/d. Call the scenario name “Sludge flow at Prim 

Clar”. The scenario result provides an influent wastewater flow rate as indicate in the Figure 

3-34 below. 

 

Figure 3-34 Back-solver results for flow rate  
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4. ADDITIONAL TOPICS 
 

In this chapter a few additional topics are discussed to help the user understand TOXCHEM 

V4.3 functionalities.  

4.1 IMPORTING V3 LAYOUTS 

LAYOUTS WITH COMPOUNDS IN STANDARD DATABASE 

For importing the layouts in which only the contaminants from the standard V3 database are 

modeled, use the File – Open command to open the V3 layouts with .wtp extension. If the 

layout contains unit process of DAF, newly defined oil connection will have to be connected to 

an oil effluent before the layout could be simulated. 

LAYOUTS WITH USER DEFINED COMPOUNDS 

If the layout contains a user defined contaminant in it, then it is first necessary to import the user 

defined compound database in the V4 database before importing the layout. The V3 user 

defined contaminant database file shall be available in the TOXCHEM V3 install directory. The 

user chemical and metal database files are named USCHEM3.DB and USMETAL3.DB 

respectively. To import these V3 user database files in V4 and later, following step may be used 

for importing organic chemical compound data. 

1) Select View Organic Chemical Database from the Databases menu item 

2) Click on the Import Database from File command button available on the bottom left of 

the organic compound display panel.  

3) Select the database file 

If the name of the user defined contaminant does not conflict with the compound name already 

existing in the database, the compounds will be imported into the database. Set the filter to 

User-Compounds to see the list of imported compounds. If a conflict is found then a pop-up 

window will show up (Figure 4-2), presenting several choices for overwriting, skipping or 

appending a descriptor to the name of the conflicting compounds.  

 

Figure 4-1Choices when importing user compound which pre-exist in database 
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Same steps can be followed for importing the metal compounds, except that in step #1, select 

View Metals Database instead of View Organic Chemical Database from the Database 

menu. 

After importing the user defined database, import the layout by following the steps listed in 

previous section. 

Caution: Due to the differences in the grid structure of V3 and V4 (or later versions), it is 

sometimes possible that all of the unit processes defined in V3 are not imported in V4. In such 

situation, user may have to modify V3 layout to make it compatible for V4 import. If you 

encounter this issue, please contact Hydromantis for more details regarding how to modify your 

V3 layout. 

4.2  HOW TO CREATE USER DEFINED GROUP OF CONTAMINANTS 
The user can create a user defined group of contaminants, which are regularly used in analysis. 

By using a user defined group of contaminant, the user can avoid the step of individually 

selecting the contaminant each time. Following steps may be used to create a user defined 

group of contaminants. 

1) Select Edit ‘Quick Select’ Groups from the Database menu item 

2) In the Quick Select Contaminant Groups window as shown in Figure 4-2, click on 

the + button next to select group and enter the name of the group in the pop up 

window. 

3) Find the contaminant name from the organic chemicals or metals and press the 

transfer arrow to transfer the contaminant to the Current chemicals window. 

4) For example, if you enter “Test” as the group name containing Benzene, Ammonia 

and Dichlorobenzene 1,2, the Quick Select Contaminant Groups window should look 

as shown in Figure 4-3 after the first three steps. 

5) Press Accept to create the group. 

6) You can easily add the group of contaminants in an influent object by pressing on the 

Quick Select button (Figure 4-4) and selecting the contaminant group of choice. 
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Figure 4-2 Quick Select Contaminant Groups window for creating/editing 
contaminant groups 

 

 

Figure 4-3 Window showing the user defined contaminant group “Test” 
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Figure 4-4 Using Quick Select to add the contaminant group to an influent object 

 

4.3 HOW TO SET SRT BASED WASTAGE IN SECONDARY 

CLARIFIER 
TOXCHEM V4 (and later) allows users to automatically estimate the Waste Activated Sludge 

(WAS) flow rates based on the Sludge Retention Time (SRT) specified in the biological tanks. 

This SRT based WAS flow waste algorithm is in addition to the method of specifying the sludge 

flow rate split fractions. The SRT based WAS flow rate estimation method is available only when 

there are two streams originating from the underflow of the secondary clarifier. To setup the 

SRT based WAS flow rate estimation, following steps may be used. 

1) After the process layout is completed with all the stream connections, right click on the 

secondary clarifier object and select Edit Parameters item. Access the Flow Split tab.  

The Secondary Clarifier with the Flow split tab shall appear as shown in Figure 4-5. 

2) In the Flow Split tab select the Calculate split fractions. This shall change the Flow Split 

window to as shown in Figure 4-6. 

3) SRT based WAS flow rate estimation require a) specification of the biological tanks, the 

biological mass of which will be used in WAS flow rate estimation and b) the correct 

specification of the WAS flow line. 

4) The biological tanks which are included in the wastage flow calculation can be selected 

from the list of tanks that appears by clicking on Edit button (Figure 4-7). Select the 

tanks whose sludge mass needs to be considered in the SRT based WAS estimation. In 

this example, select the AS-diffused tank. 

5) Next we need to specify the WAS stream correctly. If the indicated WAS stream is not 

correct, the WAS and Recycle flow lines can be switched. In this example, the Sl_0 shall 
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be Recycle while Sl_1 shall be the WAS line. Pressing on the  should change the 

order. 

6) After the setup, the final window shall look like Figure 4-8. 

7) Press Accept to commit the changes. 

 

 

Figure 4-5 Flow Split tab of secondary clarifier process unit 
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Figure 4-6 The Flow Split tab after selecting the Calculate Split fraction method 

 

 

Figure 4-7 List of tanks that can be used in WAS split calculation (layout specific) 
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Figure 4-8 Flow Split Tab after correct specification for SRT based WAS flow rate 
estimation 

4.4 HOW TO CREATE MULTIPLE LAYOUTS IN SAME FILE 
TOXCHEM V4 (and later) allows user to work with different process layouts in one file. This is 

useful to the user, if it is required to compare two or more different process layouts with few 

changes. The new layouts can be added in the file by using the following steps. 

1) From the Layout menu choose Insert to add a blank layout to the file. To create a 

duplicate of a layout, use the Duplicate item inside Layout Menu. 

2) The layout name can be changed by accessing the Rename item from the Layout 

menu. 

In Figure 4-9, the Layout1(2) is created by using the Duplicate command on Layout1. The 

commands associated with Layout menu may also be accessed by right clicking on the Layout 

Name shown at the bottom left of the drawing area. 
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Figure 4-9 Screen showing multiple layouts in same file 

 

4.5 HOW TO CHANGE THE PH GLOBALLY AND LOCALLY 
TOXCHEM V4 and later allows the user to model the volatilization of compounds considering 

pH dependent dissociation. The pH value in each unit process of the layout can be either 

changed globally or locally. For example if the pH value in all the unit processes is same then it 

is easier to change the global pH value. By default the global pH value is set to 7.0. To change 

the global pH value, following steps may be used. 

1)  In Layout menu, click on the Site Properties. 

2) Set the value in the Site Wide pH 

It shall be noted here, that the set values are specific to the layout which is active at the time of 

setting.  

The pH for an individual unit process may be changed in the Data Entry window of the process 

unit (right click on object and select Edit Parameters to open the Data Entry window). Click on 

the selection box next to Local pH Value to activate the data entry field. Enter the local pH 

(Figure 4-10 ) and press Accept to confirm the change.  
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Figure 4-10 Changing local pH value 

 

4.6 HOW TO ZOOM IN-ZOOM OUT 
The user can use the View  Zoom command to Zoom In – Zoom out the layout. Three Zoom 

buttons are also provided on the tool bar. The Zoom Selected Area button on the tool bar may 

be used to zoom in the selected grid. The Zoom Plant button may be used to zoom to the 

region occupied by the layout. An additional Zoom Out command button is also provided on the 

tool bar. This button may be used to increase the number of rows and columns in the drawing 

board view. 

4.7 HOW TO TURN ON/OFF THE PROCESS TABLE, FATE 

SUMMARY AND HOT SPOTS TOOL BARS 
The default user interface of TOXCHEM V4 shows the panels for Process Table, Fate Summary 

Tables and Hot Spots Setup (Figure 4-11). The panel views can be turned ON/OFF by using 

the View  Toolbars command. Select or unselect the Unit Process, Hotspot or Fate 

Summary to open or close these panels. Figure 4-12 shows the interface when all the panels 

are closed. 
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Figure 4-11 Default interface view with Process Table, Fate Summary and Hot 
Spot panel views turned ON  
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Figure 4-12 Interface view with all the panel views turned OFF 

4.8 HOW TO REARRANGE THE FLOW LINES  
 The flow lines can be rearranged for better representation and better tracing of the connection 

points. Rearranging the flow lines can improve the appearance of the plant layouts. In addition 

to moving the flow lines in horizontal and vertical directions, it is possible to add break points to 

create additional line segments. Following step demonstrate the procedure. 

1. Place the cursor on the line which you want to move. The mouse cursor will change into an 

arrow and the selected connection line will automatically turn into red color (Figure 4-13). 

Press the Left mouse button and move the line in indicated direction. 
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Figure 4-13 Highlight the connection line for rearranging 

 

2. For creating a break-point, right click the line at the point where the break point is desired. 

From the pop-up menu, click on break point.  

4.9 HOW TO READ CONTAMINANT CONCENTRATION FROM 

EXCEL FILE  
This feature allows user to import concentration of contaminants in the influent object from an 

EXCEL file. This is useful when concentrations of a large group of contaminants are recorded in 

EXCEL sheet and is required for analysis. This feature saves time in data entry and eliminates 

chances of erroneous input. Following procedure may be used to import contaminant 

concentration data. In the following example, we will be importing the contaminant and their 

concentration shown in the March2012 worksheet of the EXCEL workbook (Figure 4-14). 

[Note: the contaminants names in the EXCEL sheet should correspond to the exact name in the 

database. If a contaminant does not exist in the database, it will not be imported from the 

worksheet. Also use only the A, B, C columns for contaminant name, concentration and unit 

respectively. The concentration unit shall be the one that is recognized in TOXCHEM (g/m3, 

mg/L, ug/L, g/L or ppm) ]. 
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Figure 4-14 EXCEL data file 

 

Click on the Contaminants tab in the Influent object Edit Parameters menu (Figure 4-15). 

 

Figure 4-15 Import button in wastewater influent 
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1. Click on Import button to import the contaminant concentrations from the EXCEL 

worksheet. Select the location where the EXCEL data file is stored, select the file and 

open it. 

2. A Worksheet Selection window (Figure 4-16) pops up to confirm which sheet to import 

data from. In this example March 2012 is selected. Press Accept. 

3. An error window (Figure 4-17 ) will appear and report any rows are that are not 

imported due to contaminant name or unit mismatch. In this example the first row 

contains the header in the worksheet and this is ignored. Close the error window. 

 

 

Figure 4-16 Sheet Selection for data import 

 

 

Figure 4-17 Error reporting window 
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The contaminants and their concentration can be seen the contaminant window (Figure 4-18). 

Accept to close the window. 

 

Figure 4-18 Imported contaminant and concentrations (March2012) 

Now, if we use the import feature one more time and import the data from the April2012 sheet, 

the concentrations changes as in Figure 4-19. 
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Figure 4-19 Imported contaminant and concentrations (April2012) 

 

4.10 HOW TO VIEW STREAM PROPERTY QUICKLY  
 

To view the properties of a stream, right click on the stream and select “View Stream States”. 

The pop-up window will show the calculated values of the stream properties as in Figure 4-20. 
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Figure 4-20 Viewing Stream Properties 

 

4.11 HOW TO IMPORT FILE DATA FOR VARIABLES ON QUICK 

ADJUST TOOLBAR 
 

Toxchem allows user to export and import data of model variables from an EXCEL file. For the 

export and import of variable data to wok, the selected variables shall be available on the Quick 

Adjust Toolbar. A data import file with correct format can be created by first exporting data from 

the Quick Adjust Toolbar to an EXCEL file. In the Tutorial example, an export EXCEL file can be 

created by clicking on the Options button on Quick Adjust Toolbar and selecting “Export Values 

to File”. Save the file with appropriate name. The data format in the saved file will appear as 

shown in Figure 4-21. 
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Figure 4-21 Excel File Created Using Data Export Feature 

 

For a situation where monthly emission reports needs to be prepared, a user can create data 

input files for each month by changing the observed operational values. For example, a data file 

for March 2013 can be created by changing the values and saving the file as 

tutorial_InputData_March2013.xls as shown in Figure 4-22. 

 

Figure 4-22 Data Input File for March 2013 
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 Once the input data file is created, the file data can be imported to the variables on the Quick 

Adjust Toolbar. The data can be imported by accessing the “Import Values From File” command 

from the Options button on the Quick Adjust Toolbar. Select the correct input file from where 

data needs to be imported (tutorial_InputData_March2013.xls). After the import, the data values 

on the Quick Adjust Toolbar shall appear as shown in Figure 4-23. 

 

Figure 4-23 Variable Values On Quick Adjust Toolbar After Data Import 
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5.  APPENDIX-A 

5.1 Version 4 
Some of the parameter values which were hard coded in V3 simulation system are now 

provided in the advanced parameter setting tab. Based on experience over the years, some of 

these hard coded values were updated with new defaults in TOXCHEM V4 (and later). The 

changes in the parameter default values are as shown in Table 5-1. These new default values 

are carried forward in TOXCHEM V4.3. 

5.2 Version 4.1 
Corrections to EPA air emission database compounds: Please refer to Technical Memorandum 

No. 2012-001. These updates were made in TOXCHEM V4.2. 

Corrections were made in the oxygen density estimation procedures. Please refer to Technical 

Memorandum No. 2012-002. 

5.3 Version 4.3 
The technical literature for values of Henry’s law coefficients for ammonia and hydrogen sulfide 

was reviewed extensively.  Based on the data reviewed, new values of Henry’s law coefficients 

of 0.000661 Lliq/Lgas for ammonia and 0.4035 Lliq/Lgas for hydrogen sulfide were adopted and 

carried forward in V4.3.  The detailed documentation regarding the selection of the values for 

these two compounds is provided in Technical Memorandum No. 2014-001. 
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Table 5-1 Changes in default parameter values 

Unit Process/Parameter Unit V3 
Default 

V4  
(and 
later) 
Default 

Explanation 

Drop Structure - Closed     

Kg/Kl Ratio for Drop  3 100 Same as Weir 

Drop Structure - Open     

Kg/Kl Ratio for Drop  3 100 Same as Weir 

Grit Chamber     

Kg/Kl Ratio for Diffused 
System 

 40 3 Air bubble coming in contact with Liquid 

Equalization - Mixed/Aerated     

Kg/Kl Ratio for Diffused 
System 

 40 3 Air bubble coming in contact with Liquid 

Dissolved Air Flotation     

Oxygen Transfer Efficiency % 50 25 OTE reduced based on experience 

Kg/Kl Ratio for Diffused 
System 

 40 3 Air bubble coming in contact with Liquid 

Activated Sludge - Diffused Aeration     

Kg/Kl Ratio for Diffused 
System 

 40 3 Air bubble coming in contact with Liquid 

Activated Sludge - Diffused/Mechanical 
Aeration 

    

Kg/Kl Ratio for Diffused 
System 

 40 3 Air bubble coming in contact with Liquid 

Trickling Filter     

Kg/Kl Ratio  4 40 Same as mechanical aeration in which 
liquid droplets come in contact with air 

Biofilm Thickness mm 0.1 1 Based on experience from modeling 
fixed film processes 

Stagnant Liquid Layer 
Thickness 

mm 0.1 0.05 Based on experience from modeling 
fixed film processes 

Rotating Biological Contactor     

Kg/Kl Ratio  4 40 Same as mechanical aeration in which 
liquid droplets come in contact with air 

Biofilm Thickness mm 0.1 1 Based on experience from modeling 
fixed film processes 

Stagnant Liquid Layer 
Thickness 

mm 0.1 0.05 Based on experience from modeling 
fixed film processes 

Channel     

Oxygen Transfer Efficiency % 2 6  

Cooling Tower     

Kg/Kl Ratio  700 40 Same as mechanical aeration in which 
liquid droplets come in contact with air 

Volatilization Mass Transfer 
Coefficient 

m/d 0.8 0.2 Same value as in the trickling filter 

Aerobic Digester     

Kg/Kl Ratio for Diffused 
System 

 40 3 Air bubble coming in contact with Liquid 

 

 


